# Table Of Contents

Preface ................................................................................................................................. 1
  Purpose ................................................................................................................................. 1
  Audience ............................................................................................................................. 1
  Organization ......................................................................................................................... 1
  Obtaining Documentation, Obtaining Support, and Security Guidelines 1
  Documentation Feedback ..................................................................................................... 1

1. Initial checks ................................................................................................................. 2
   End User Checks .............................................................................................................. 2
   Critical Services .............................................................................................................. 2
   User Rights ...................................................................................................................... 3
   Network Connectivity ...................................................................................................... 3

2. Windows Operating System Checks ........................................................................... 4
   Event Logs ......................................................................................................................... 4
   Disk Space and Memory Usage ....................................................................................... 4

3. SQL Server Checks ....................................................................................................... 5

4. Unified Contact Center Management Portal Checks .............................................. 6
   Connectivity ....................................................................................................................... 6
   SQL Server Transactions ................................................................................................. 6
   Logs .................................................................................................................................. 7
   Audit Reporting ............................................................................................................... 7
   System Monitoring ......................................................................................................... 8

5. Common Issues ............................................................................................................ 9
   Database Server Errors ................................................................................................. 9
Preface

Purpose

This document explains some solutions to issues you might encounter and answers some questions about Cisco Unified Management Portal (Unified CCMP).

Audience

This document is intended for all users of Unified CCMP, from high-level administrators to team supervisors. The reader needs no technical understanding beyond a basic knowledge of how to use computers.

Organization

Chapter 1, "Initial Checks"
Lists the initial checks to make if you experience problems with Unified CCMP.

Chapter 2, “Windows Operating System Checks”
Describes how to check aspects of the Microsoft Windows platform, including memory usage and disk space.

Chapter 3, "SQL Server Checks"
Describes how to check for possible MS SQL Server issues.

Chapter 4, "Unified Contact Center Management Portal Checks"
Explains how to troubleshoot connectivity problems and where to find diagnostic information within Unified CCMP.

Chapter 5, "Common Issues"
Describes some problems commonly encountered while using Unified CCMP and how to fix them.

Obtaining Documentation, Obtaining Support, and Security Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and also recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

Documentation Feedback

You can provide comments about this document by sending email to the following address:
Initial checks

This chapter explains basic information to obtain when investigating system issues.

End User Checks

- Exact operation being performed
- Names, dates and other parameters being used in that operation.
  For audit reporting errors, this should include:
  - Which report was run
  - The from/to dates the report was using
  - Which users are affected
- Details of the behavior
- Any error message
- If possible, a screen shot of the end result or error

Application Error Codes

Unified CCMP does not use status codes to convey information through the system. User-friendly error codes, combined with the context of what a user was doing when they encountered the error, should be sufficient to diagnose and resolve problems.

Unified CCMP also displays errors returned by Unified ICMH, Unified ICME and Unified Communications Manager. These are visible through the audit reports provided and also in the history tab for each resource item. These error messages are always displayed in US English and are documented on the Cisco web site.

Critical Services

All Servers

Ensure that the following services are running on all servers:
- .NET Runtime Optimization Service
- COM+ Event System
- HTTP SSL
- IIS Admin Service
- World Wide Web Publishing Service

Database Servers

Ensure that the following services are running on all Database Servers:
- SQL Server (MSSQLSERVER)
- SQL Server Agent (MSSQLSERVER)
- UCCMP Data Import Server
- UCCMP Provisioning Server
- UCCMP Replication Publisher
- UCCMP Replication Subscriber

**Web Application Servers**

Ensure that the following services are running on all Web Application servers:
- ASP.NET State Service
- UCCMP Application Search Services
- UCCMP Application Server
- UCCMP System Monitoring Services
- UCCMP Scheduling Services
- Report Server

**User Rights**

Ensure that the Network Service and sql_agent_user accounts have log on as a service permissions.

**Network Connectivity**

Ping each of the servers to ensure all are available.
1. Windows Operating System Checks

Event Logs

Open Event Viewer from Start > All Programs > Administrative Tools > Event Viewer.

On the Database Servers, look for errors raised by the following:
- SQL Server
- SQL Server Agent
- UCCMP Services

On the Web Application Servers, look for errors raised by the following:
- IIS
- MS Reporting Services
- Management Portal Services

Disk Space and Memory Usage

Use the Task Manager to check CPU and Memory utilization. High CPU and/or memory usage might impair performance and is often caused when inappropriate applications (such as some screensavers) are run on the system.

Low disk space might cause problems if the SQL Server database and Transaction Log do not have enough space to grow when required. This typically results in provisioning failures.
2. SQL Server Checks

1. Check that SQL Server has been allocated no more than 70% of the RAM in the server (or 50% for single-sided, standalone installations). Allocating more RAM than this results in poor performance from the other applications (including Management Portal components) on the server.

2. Ensure that dynamic RAM allocation is not being used, as this often results in over-allocation.

3. Open up Management Studio from Start > All Programs > Microsoft SQL Server > Management Studio and check database and Transaction Log space utilization.

4. In Management Studio, check the Replication Monitor for failing replication events.

5. Ensure that all scheduled tasks are reporting success. For details of any failing tasks, right-click on that task and select the Task History option.
3. Unified Contact Center Management Portal Checks

Connectivity

Web Application Server to Database Server

1. Create a shortcut on the desktop of the Web Application Server with the file extension .udl.
2. Double-click the link to open the Data Link Properties window.
3. On the Provider tab, select OLE for SQL Server.
4. On the Connection tab, enter the necessary details to connect to SQL Server.

Common error messages include:

Login Failed/Access Denied The user name or password are incorrect / do not have access to the SQL Server.

SQL Server is unavailable or does not exist The client was unable to access SQL Server over the network. Possible causes include:

- Broken NW connection
- DNS resolution failure
- SQL Server Service or System down

All error codes presented through this interface are standard SQL Server messages.

Database Server to Unified CCE/ Unified CCH

Use the SQL Server Management Studio to sign in to the Admin Workstation from the Database Server using SQL Server authentication.

SQL Server Transactions

The SQL Profiler allows you to monitor transactions being executed against a database.

1. Open the profiler from All Programs > Microsoft SQL Server > Performance Tools > SQL Server Profiler.
2. Click File > New Trace and connect to the server.
3. In the Events tab, select the following events:
   - Stored Procedures RPC:Completion
   - TSL SQL:BatchCompleted
4. Click Run.

You can also choose to filter the requests, for example by Application Name. Most Management Portal requests will show as Management
Portal Application Primary, although errors in reporting show as Report Server.

**Note** The SQL Profiler only shows SQL that has executed. Broken/malformed SQL might never be executed and therefore might not show up in the profiler.

**Logs**

**AppServer Log**

On the Web Application Server, navigate to the location where the Application Server Component was installed. By default, this is `C:\Program Files\Management Portal\Application Server`. Open the latest log file contained within the `Logs` folder.

Search for ‘Exception:’ and examine the details.

**IIS Log Files**

Web log files are found at `C:\WINDOWS\system32\LogFiles\W3SVC1\ex<YYMMDD>.log`. These contain details of all web server transactions, and refer to standard HTTP status codes.

A full list of HTTP status codes can be found at [http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html](http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html). Some routine codes include:

- 200 - OK
- 401 - Failed Authorization
- 404 - Page Not Found
- 500 - Internal Server Error

**Configuring the Web Log**

The logging output level for the Web Log is configured in the file `web.config` in the location where the Web Server component was installed. By default, this is `C:\Program Files\Management Portal\Web`.

```xml
    <system.diagnostics>
        <switches>
            <!-- 0 - none, 1 = error, 2 = warning, 3 = info, 4 = verbose -->
            <add name="LogLevelSwitch" value="2"></add>
        </switches>
        <assert assertuienabled="false"></assert>
    </system.diagnostics>
```

**Note** Verbose level tracing should not be used in a live system except for very short periods in extreme situations.

**Audit Reporting**

Audit trails for individual items and audit reports for an overview of provisioning are available from the Unified CCMP user interface. More
information on how to use these is available from the Administration Manual for Cisco Unified Contact Center Management Portal and the User Manual for Cisco Unified Contact Center Management Portal.

System Monitoring

The status of any system connections can be monitored from the Configuration Manager on the Database Server or from the Monitor Report. These are described more fully in the Administration Manual for Cisco Unified Contact Center Management Portal.
4. Common Issues

Database Server Errors

Required Initial Data Import Never Stops

When installing, it is necessary to import data before setting up Cisco Unified Communications Managers. In some cases, this import does not appear to stop. This may indicate a database connection failure.

Use the Management Studio to verify that data is being imported to TB_DIM_AGENT in the database created by Unified CCMP. By default, this is the Portal database. If it is, the import is proceeding normally.

If no data is being imported, ensure that the Read-only user on the Admin Workstation databases has DataReader permissions and that other details such as the password are correct.

Active Importer Server Crash

If a server crash or otherwise unrecoverable error occurs on the active importer, then the other side needs to be brought into service as quickly as possible. The Data Import Server is designed to minimize the down time before importing can be restarted.

The following steps describe the actions to perform on the inactive side.

1. Turn off the Data Import Server and Management Portal Replication Subscriber. It is very important that these services shut down properly otherwise the system may be in an inconsistent state. If either of these fails to shut down properly, then they should be restarted and allowed to run for at least 30 minutes. This should give them sufficient time to recover their state and roll back any inconsistencies.

2. Check the TS_IMP_DIRECTORY_STATUS table. This table contains one row for each replicated session directory. If there are any rows in this table that have a status other than F, then the database state is inconsistent. The only recourse is to restart the Data Import Server to give it time to recover. After approximately
30 minutes (see Step 1, above) shut down the Data Import Server service again. If there are still unfinished session directories, then a double error has occurred in the platform. To correct this problem, you must restore the database from backup before proceeding with the import.

3. Assuming the services shut down correctly and there were no unfinished session directories in the **TS_IMP_DIRECTORY_STATUS** table, the next step is to completely clear out the **Replicated** folder. This folder contains imported information from the crashed server and cannot be guaranteed. The data may also contain references to resources that will never arrive as the SQL Server replication link is down.

4. Finally, set the import token to active and restart the Data Import Server services. The process for restoring what was the active importer is described in the next section.

**Inactive Importer Server Crash**

Another failure mode to consider is a server crash which is not the active importer.

This scenario does not break import processing on the active importer. Data continues to be imported on the active side, and session directories accumulate in the **ToReplicate** folder. These session directories cannot be replicated to the other side, as it is unavailable. They therefore quickly use up available disk space.

The recommended approach is to re-configure **Replication.xml** on the active importer and remove the crashed server. All entries in the **ToReplicate** folder should then be deleted. This configuration change stops the disk filling up on the active importer.

```xml
<Replication>
  <Publisher PublisherId="ReplicationPublisher"
    ChunkSize="65536" Directory PollInterval="1000"
    BroadcastPeriod="10000"
    ToReplicateDirectory="\Importer\ToReplicate"
    ReconnectionPeriod="15000">
    <LinkedServers>
      <Subscriber Name="RemoteSubscriber" Address="127.0.0.1"
        Port="7500" />
  </LinkedServers>
</Replication>
```
Once the failed server has been fixed, perform the following steps:

1. Switch off the Data Import Server and Unified Contact Center Management Portal Replication Publisher / Subscriber services.
2. Delete everything in the ToReplicate and Replicated folders on both servers.
3. Switch off SQL Replication between the two databases.
4. On the active importer take a snapshot of the SQL Server database and restore it on the failed side. At this point both databases contain identical data.
5. Bring up SQL Server replication between the two databases.

Each table imported by the importer has a tide mark. The tide mark is essentially a bookmark storing the location where everything has been imported up to. Everything after the tide mark has yet to be imported. The importer imports a chunk of available data from each file in turn and updates the tide mark afterwards. The tide marks are stored in a table called TB_IMP_TIDEMARK.

Make the following changes on the failed server:

1. The tide marks in TB_IMP_TIDEMARK will be incorrect once the database has been restored on the failed side. Delete all rows from the table that contains the failed server RESOURCE_INSTANCE_ID. On the failed server call ap_clu01_get_exony_db_resource_instance from SQL Server Management Studio to get its RESOURCE_INSTANCE_ID.

2. After deleting all the rows for the failed database server, duplicate each remaining row in the TB_IMP_TIDEMARK table. Each duplicated row must have its RESOURCE_INSTANCE_ID changed to the failed server identifier. Doing this ensures that both servers have identical tide marks and so match the data in the fact tables and dimensions.
Use the following SQL script to update TB_IMP_TIDEMARK:

```sql
CREATE TABLE #TEMP (RESOURCE_INSTANCE_ID UNIQUEIDENTIFIER, CATALOG VARCHAR (50))
INSERT #TEMP
EXECUTE ap_clu01_get_exony_db_resource_instance
DECLARE @v_RESOURCE_INSTANCE_ID UNIQUEIDENTIFIER
SELECT @v_RESOURCE_INSTANCE_ID = RESOURCE_INSTANCE_ID FROM #TEMP
DELETE FROM TB_IMP_TIDEMARK
WHERE RESOURCE_INSTANCE_ID = @v_RESOURCE_INSTANCE_ID
INSERT TB_IMP_TIDEMARK
(CLUSTER_RESOURCE_ID,
 TABLE_NAME,
 RESOURCE_INSTANCE_ID,
 TIDEMARK1,
 TIDEMARK2,
 TIDEMARK3,
 TIDEMARK4)
SELECT
 CLUSTER_RESOURCE_ID,
 TABLE_NAME,
 @v_RESOURCE_INSTANCE_ID,
 TIDEMARK1,
 TIDEMARK2,
 TIDEMARK3,
 TIDEMARK4,
FROM TB_IMP_TIDEMARK
```

Audit data is not replicated through SQL Server but through the Unified CCMP Replication system. When importer session files are replicated from one side to another, they are bulk-loaded by the Data Import Server into the database. As this process takes place, the Data Import Server logs its progress into a series of state tables in the database.

These importer state tables are replicated using standard SQL Server replication but are uniquely identified on each side by a RESOURCE_INSTANCE_ID. The system on each side uses these state tables to track the arrival of new data into the database fact tables for further processing.

**TB_IMP_FCT_PARTITION** is the base state table. This contains a definition of all the fact table partitions that have been created on each side. There are usually two identical rows in here, differentiated by RESOURCE_INSTANCE_ID (one for each side). This table links to **TB_IMP_FCT_PARTITION_TIDEMARK** and **TB_IMP_FCT_PARTITION_TIDEMARK_SLICE**.

Unfortunately, when one database is restored to another side, these state tables are no longer correct. As a result, data may exist in the fact partitions in the restored database that the system is unaware of. The following steps recover the state tables on the failed database. It is very important that SQL Server replication is running while you perform these steps.
3. Delete all data from **TB_IMP_FCT_PARTITION** with the **RESOURCE_INSTANCE_ID** of the failed database. This should cascade delete data from all the other state tables.

4. All the data in the following tables must be duplicated using the failed database **RESOURCE_INSTANCE_ID**. This essentially matches the state tables with the actual data in the database fact tables.
   - **TB_IMP_FCT_PARTITION**
   - **TB_IMP_FCT_PARTITION_TIDEMARK**
   - **TB_IMP_FCT_PARTITION_TIDEMARK_SLICE**

5. Reset **Replication.xml** on the active importer.

6. Restart the Data Import component server service along with Unified CCMP Replication Publisher / Subscriber services on both servers.
   The Data Import component server will start importing and replicating data to the other side as normal.

**Recovery after No Disk Space Available**

If there is no disk space for the importer, it will continue trying and failing to import data until disk space is made available. However the importer should always reset Unified CCMP database to a consistent state. Sometimes the importer cannot back out changes it has made to the database until disk space is made available. For example, disk space is often required by the SQL Server transaction log before changes are committed.

There are several places where running out of disk space can cause an import to fail. For example when the importer reloads a dimension cache, it saves it to a session file on disk. The same occurs when the importer is processing downloads from the Admin Workstation. It is therefore difficult to specify exactly where the importer will fail when there is no disk space left.

In all cases the importer should generate an exception (visible in the importer trace) and stop the current import. Once disk space is made available, the importer should reset the database to a consistent state and start importing again.
Network Disconnects in Replicated Environments

There are two types of replication connection between the database servers. The first is SQL Server replication, which is used to replicate dimension, member and administration tables in Unified CCMP database. The second connection is used by the Data Import Server to replicate audit data between the systems.

If this connection is broken, both replication connections are expected to stop.

While the connection is down, disk space will fill up on the active importer. This is because it is accumulating session files from the running importer which cannot be replicated to the other side. Once the connection is re-established the session files waiting to be replicated will be processed and data should not be lost as a result.

Once the connection is re-established, both connections should start working again and catch up where they left off. For SQL Server replication this can be monitored through the Management Studio Replication Monitor. Data Import Server replication can be monitored by opening Windows Explorer on the configured ToReplicate folder.

Replication Fails on Replication Restart

Transaction Log Full

An extended interruption of replication may result in the Transaction Log becoming full. No logged operations can be performed while the Transaction Log is in this state.

First, check that the transaction log is indeed full. If certain that the underlying issue has been fixed, extend the Transaction Log. This allows operations to be performed again. Once the system has recovered, use DBCC SHRINKFILE to shrink the log back to normal size.

Record Duplication

It sometimes happens that while replication is down, the same user is created on both the publisher and the subscriber. When replication is brought back up again, the presence of two records containing fields that must be unique (such as the login name) causes replication to fail.
You can confirm this problem by checking the Event Viewer for an event with a description that includes the phrase ‘violation of UNIQUE KEY constraint’.

To solve this problem, it is necessary to delete one of the duplicate records.

To find the record causing the problem:

1. Go to the subscriber database and expand the Portal database
2. Navigate to Replication Monitor > Publishers > Publisher Database Name and click on Base:Portal publication.
3. In the left-hand window, right-click on the Distribution Agent for Base publication. This will be displayed as Subscriber Database Name:Portal.
4. Select Agent History to open the Distribution Agent History window, which displays information about the error and the place where the conflict is occurring.
5. To find the record in the table where this error is occurring, right-click the Base:Portal publication (Replication Monitor > Publishers > Publisher Database Name) and click View Conflicts. This opens the Replication Conflict Viewer window.
6. Select the table that you suspect the conflict to be in and click View.
7. Click on **Postpone Resolution** until you reach the place where you suspect the conflict is not resolved. In the above case it is the BillThomson LOGIN_NAME that is creating a conflict.

You must then manually check on both sides for the duplicated record and delete one of them from the system. Once this is completed, the system will immediately replicate all records that were pending replication.

**Re-sychronizing Replication**

If normal replication is suspended for an extended time (by default, this is two weeks), it will be necessary to re-initialize replication.

From SQL Server Management Studio, check that re-synchronization is needed. Then right-click on the Publication to be re-synchronized and select the **Reinitialize** option. Monitor the progress of the Snapshot agent to ensure it completes successfully.

**Domain Controller was Rebooted**

Rebooting a domain controller occasionally causes problems. The solution is to reboot Unified CCMP servers. If domain security policies do not allow cached account credentials, then the domain controller must be available when Unified CCMP servers restart to authenticate the servers against the domain.

**Taking a Cisco Admin Workstation Offline**

No special action needs to be taken in this instance. While an Admin Workstation is offline, Unified CCMP is unable to import any data from
that system. It will, however, continue to import data from other Admin Workstations as normal.

Because the Admin Workstation is offline, no provisioning actions are completed for the tenant who has been allocated that Admin Workstation. This means that tenant’s resources remain in a synchronizing state forever. Once the Admin Workstation is back online, the system automatically starts using it again.

**System Monitoring / Monitoring Report Shows Errors**

This is typically because the remote system (Unified CCE, Unified CCH or Unified CM) is not currently available. This might be because of a network disconnection or other service fault on the remote system. It is probably worth checking that the Unified CCE/Unified CCH is up and running correctly (in particular the CMS control in Configuration Tools).

**Cannot Login to Phone / Phone Does Not Ring**

It is not possible to log into the phone if the Unified Communications Manager peripheral user name is entered incorrectly in Unified CCMP Configuration Manager. Furthermore Unified ICME/ICMH will not be able to control the phone properly, and it will not ring.

The solution is to first correct the peripheral user name in Unified CCMP Configuration Manager tool. Then load each phone in the System Manager tool in Portal’s web interface and save. Once you do this, Unified CCMP will update the Unified Communications Manager/ and reconfigure the phone correctly.

**Note** Do not change the peripheral user name after the system is commissioned. Each peripheral user name must be unique across a peripheral.

**Web Application Server Errors**

**A Tenant’s Resources are not being moved to the Correct Folder after Import**

1. Login to Unified CCMP as a *system administrator*.
2. In the **System Manager**, navigate to the folder containing the tenant.
3. Click on the tenant and wait for the right hand pane to load.
4. Click the **Prefixes** table and edit the prefixes as appropriate.
5. Click **Save** to submit the changes into the system.
For Unified ICME/ Unified ICMH, the prefix management works from the resource’s enterprise name. In the example rule above, if the agent’s name begins with abe then it will automatically be moved to the folder /ipcc1/Q A Testing. If more than one prefix rule is applicable, then the rule with the lowest priority number is used.

Unable to View Resources in System Manager

This is probably because the user does not have Browse Dimensions security privileges. It is best practice to assign security permissions through security groups rather than to individual users. The User Manual for Cisco Unified Contact Center Management Portal explains how to configure security users / groups and how to assign permissions to them.

Unable to Provision Resources through System Manager?

The user probably needs a global provisioning security privilege, for example, Provision Agent. It is best practice to assign security permissions through security groups rather than to individual users. Unified CCMP User Guide explains how to configure security users / groups and how to assign permissions to them.

Resource Stays in Pending Active State Forever

This might occur if the system has been unusually busy. First check the history tab for the resource. This shows any activity taken by the system for that resource. If the system unsuccessfully attempted to make a change on the Unified ICME/ Unified ICMH/ Unified Communications Manager, then that information is normally recorded in the audit history. If the audit history has not been updated, the Unified CCMP Provisioning Server might not be running.

When Creating New Item, Error Indicates Resource Already Exists

This indicates that the resource you are trying to create shares a field that must be unique, such as a Person’s login name or a Dialed Number’s number, with an existing resource.

If no duplicate resource appears to exist, this may indicate that the resource has been deleted. Deleted resources are marked as deleted but kept in the system for audit purposes, and so it is possible for a new resource to have a conflict with an old one. You can see deleted items within the system by checking the Show Deleted Resources checkbox in Settings > User Settings.

If a conflict exists you are be unable to create the new resource until you change the conflicting detail.

New Skillgroups Enter Error State

Attempting to create a skill group gives the error: ‘You do not have permission to create this object. It should be created by the Application that owns the media type on which you are attempting to create this object.'
Troubleshooting Guide for Cisco Unified Contact Center Management Portal Release 8.0(1)

[Code 40062]’ in the Skillgroup History tab. This error is caused by setting multimedia support for the Unified ICME/ICMH in Unified CCMP Configuration Manager and not setting Unified CCMP to use a Cisco Unified Web and E-mail Interaction Manager Application Instance.

If you do not have Cisco Unified WIM/EIM integrated with your version of Unified CCE/Unified CCH, log on to the Database Server, open the Configuration Manager, and uncheck the Multi Media checkbox for the relevant Unified ICME/Unified ICMH. You should also log onto the Unified ICME/ICMH and ensure that the Application Instance being used is set to Cisco Voice.

If you are using Cisco Unified WIM/EIM integrated with Unified CCE/Unified CCH, log on to the Database Server, open the Configuration Manager, and change the Application Instance details for the relevant Unified CCE/Unified CCH to correspond to those set up for the Cisco Unified WIM/EIM. Information on configuring the Application Instance for a Cisco Unified Interaction Manager deployment can be found in the Cisco Unified Web and E-Mail Interaction Manager System Administration Guide for Unified Contact Center Enterprise and Hosted and Unified ICM.

Unable to Update Skillgroup Memberships

Attempting to update an agent skill group membership gives the error: ‘“AgentSkillGroupMember failed [4, Attempt to assign a Member to a default skill group]”’ in the Agent History tab. This error is caused by an incorrect Application Instance type on the Unified ICM. Log onto the Unified ICME/ICMH and change the Application Instance type to Cisco Voice.

Unable to see Related Resources in System Manager

This is probably because the user does not have Browse Dimensions security privileges on the folders where the related resource is located. For example, to add an agent to a skill group requires Browse Dimensions security privileges on the folder where the skill group is located. It is best practice to assign security permissions through security groups rather than to individual users. The User Manual for Cisco Unified Contact Center Management Portal explains how to configure security users / groups and how to assign permissions to them.

Unable to Bulk Load Resources in System Manager

This is probably because the user does not have the Bulk Import Dimensions security privilege. This security privilege is a global task and is configured in a global role. A user must be granted the global role. The user must also be granted the provisioning global task to bulk upload particular resource types, for example Provision Agents.
Web Browser Displays “No connection could be made because the target machine actively refused it”
Check Unified CCMP services are all up and running on the web component server.

Web Browser Displays “The page cannot be found”
Check the URL in the web browser is correct (in particular the server name/IP address of Unified CCMP server).

Supervisor User has no Agents or Skillgroups menu options
Check whether the user’s home folder is one in which they have permission to manage resources.

When moving users or changing their permissions it is a common error to neglect to change their home folder. In Basic Mode, a user is automatically set to work in the folder specified as their home folder. If they do not have permission to manage dimensions in that folder, they will not be able to access the Agents or Skillgroups menu options.

This is not a problem for Advanced Users because, whereas Basic Mode presents a flat view, the tools available in Advanced Mode allow the user to change the folder in which they are working.

Sharing Unified CCE/Unified CCH Lines
In Unified CCE/Unified CCH, two types of line exist: Unified Communications Manager internal lines and Unified ICME. Unified ICMH controlled lines. For ICM controlled lines Unified CCMP automatically configures the necessary device targets and labels on ICM. Note however that an ICM controlled line can only be associated with one phone in Unified CCMP and cannot be shared. For Unified Communications Manager internal lines, multiple phones can share the same line.

Error Importing Phone
Only supported phone types are imported into Unified CCMP. All others are filtered out and are not visible in the System Manager. If the Data Import component server fails when importing a phone from Unified Communications Manager it will change the state of the phone to error. To resolve this problem, load the phone in the System Manager and click Save. The system will then synchronize the phone with Unified Communications Manager and resolve any problems.

Phone Button Templates
Button templates are imported from the Unified Communications Manager but cannot be edited or created in Unified CCMP. The number of lines can be set in a phone template on the Unified Communications Manager, but this is not reflected in Unified CCMP. This means a phone can be assigned
to more lines in the System Manager than the button template actually permits.

**Can’t See Audit Reports in Management Portal?**
This is probably because the user does not have **Browse Reports** security privileges on the folder where the audit report is located.

**“Object reference not set to an instance of an object” When Running a Report**
Unified CCMP uses an internal indexing system to keep track of all resources in the system. This can take several minutes to load after the system starts. If the system has recently started up, wait five minutes and then try again.

**No Data in Report**
1. Open the parameter set and then click **Preview**. Check that there are resources listed, as Unified CCMP uses these to generate the report.
2. If the parameter set includes folders, check that these folders exist and that the user has the **Browse Dimensions** security privileges on them.
3. Check the parameters configured when viewing the report. Some reports have date ranges that can be either relative (for example, from last week to today) or absolute (for example, from 2009-07-25 to 2009-12-31).

**Unable to Print Reports**
Printing requires a download of Microsoft Reporting Services ActiveX control to the client machine. You might need to modify the browser security settings to allow an ActiveX control download from Unified CCMP web site.
## 5. Index

<table>
<thead>
<tr>
<th>A</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Denied</td>
<td>5</td>
</tr>
<tr>
<td>Admin Workstation Taking offline</td>
<td>15</td>
</tr>
<tr>
<td>AgentSkillGroupMember failed [4, Attempt to assign a Member to a default skill group]</td>
<td>18</td>
</tr>
<tr>
<td>Application Instance</td>
<td>18</td>
</tr>
<tr>
<td>Audit trails</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Button templates</td>
<td>19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CallManager</td>
<td>8, 16</td>
</tr>
<tr>
<td>CMS control</td>
<td>16</td>
</tr>
<tr>
<td>Configuration Configuring the Web Log</td>
<td>6</td>
</tr>
<tr>
<td>Portal Configuration Manager</td>
<td>16</td>
</tr>
<tr>
<td>Connectivity</td>
<td>2, 5</td>
</tr>
<tr>
<td>Crash Active Importer Server</td>
<td>8</td>
</tr>
<tr>
<td>Inactive Importer Server</td>
<td>9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Data import disk space</td>
<td>12</td>
</tr>
<tr>
<td>Data import never stops</td>
<td>8</td>
</tr>
<tr>
<td>Missing data in database</td>
<td>11</td>
</tr>
<tr>
<td>Missing data in report</td>
<td>20</td>
</tr>
<tr>
<td>DBCC SHRINKFILE</td>
<td>13</td>
</tr>
<tr>
<td>Deleted resources</td>
<td>17</td>
</tr>
<tr>
<td>Disk space</td>
<td>3</td>
</tr>
<tr>
<td>Causing import failure</td>
<td>12</td>
</tr>
<tr>
<td>Domain Controller</td>
<td>15</td>
</tr>
<tr>
<td>Duplicate resources</td>
<td>14, 17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Manager See Management Studio Error Message</td>
<td>4, 6, 17, 18</td>
</tr>
<tr>
<td>Event Viewer</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Home folder</td>
<td>19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ICM</td>
<td>16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines Number set in template</td>
<td>20</td>
</tr>
<tr>
<td>Sharing</td>
<td>19</td>
</tr>
<tr>
<td>Logged operations</td>
<td>13</td>
</tr>
<tr>
<td>Login Failed</td>
<td>5</td>
</tr>
<tr>
<td>Logs Application Server Log</td>
<td>6</td>
</tr>
<tr>
<td>Event Log</td>
<td>3</td>
</tr>
<tr>
<td>Transaction Log</td>
<td>3, 4, 13</td>
</tr>
<tr>
<td>Web Log</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Studio Checking connectivity</td>
<td>5</td>
</tr>
<tr>
<td>Checking log space utilization</td>
<td>4</td>
</tr>
<tr>
<td>Replication monitoring</td>
<td>13, 15</td>
</tr>
<tr>
<td>Tide mark updating</td>
<td>10</td>
</tr>
<tr>
<td>Memory</td>
<td>3</td>
</tr>
<tr>
<td>Dynamic RAM allocation</td>
<td>4</td>
</tr>
<tr>
<td>SQL Server</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>No connection could be made because the target machine actively refused it</td>
<td>19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Object reference not set to an instance of an object</td>
<td>20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Page cannot be found</td>
<td>19</td>
</tr>
<tr>
<td>Pending Active</td>
<td>17</td>
</tr>
<tr>
<td>Peripheral</td>
<td>16</td>
</tr>
<tr>
<td>Phone Button templates</td>
<td>19</td>
</tr>
<tr>
<td>Error</td>
<td>19</td>
</tr>
<tr>
<td>Not ringing</td>
<td>16</td>
</tr>
<tr>
<td>Sharing lines</td>
<td>19</td>
</tr>
<tr>
<td>Prefix</td>
<td>17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Q</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Analyzer See Management Studio</td>
<td></td>
</tr>
</tbody>
</table>
### Troubleshooting Guide for Cisco Unified Contact Center Management Portal Release 8.0(1)

#### R
- Replicated folder
  - Deleting from ......................................... 10
- Replication ............................................ 4, 13
  - Extended outage..................................... 13, 15
  - Re-synchronizing .................................... 15
  - Switching off SQL replication .................... 10
- Replication.xml ......................................... 12

#### Reports
- Audit trails ............................................. 6
- Missing data ............................................ 20
- Object reference not set to an instance of an object ............................................. 20
- Unable to print ........................................ 20

#### Resources
- Deleted .................................................. 17
- Duplicate ............................................. 14, 17
- Importing to tenant folder .......................... 16
- Missing .................................................. 20
- Related .................................................. 18
- Staying in Pending Active ......................... 17
- Unable to provision ................................... 17
- Uploading ............................................... 18

#### S
- Services .................................................. 4
  - .NET Runtime Optimization Service ............. 4
  - ASP.NET State Service ............................... 2
  - COM+ Event System .................................. 4
  - HTTP SSL ............................................. 4
  - IIS Admin Service ................................... 4
  - Management Portal Application Search Services ............................................. 2
  - Management Portal Application Server ........ 2
  - Management Portal Data Import Server ........ 2, 8
  - Management Portal Replication Publisher .... 2, 8
  - Management Portal Replication Subscriber ... 2, 8
  - Report Server ........................................ 2
  - SQL Server (MSSQLSERVER) ......................... 2
  - SQL Server Agent (MSSQLSERVER) ............... 2
  - World Wide Web Publishing Service ............. 4
- Skillgroup ............................................... 17, 18
- Snapshot ............................................... 15
- SQL Profiler ........................................... 5
- SQL Server ............................................. 4

#### Troubleshooting Tips
- SQL Server is unavailable or does not exist ............................................. 5
- Transactions .............................................. 5
- State table .............................................. 11
- Recovering .............................................. 11
- Supervisor User
  - Missing menu options ................................ 19

#### T
- TB_DIM_AGENT ........................................ 8
- Telephone
  - Button templates .................................... 19
  - Error .................................................... 19
  - Not ringing ............................................. 16
  - Sharing lines ......................................... 19
- Tide mark ................................................ 10
- Update ..................................................... 11
- T-Log ..................................................... 10
  - See Logs: Transaction
- ToReplicate folder
  - Accumulating data .................................... 9
  - Deleting from ......................................... 9
  - Replication monitoring ............................. 13
- TS_IMP_DIRECTORY_STATUS .......................... 8

#### U
- Uploading resources ................................... 18
- User
  - Network Service ..................................... 2
  - sql_agent_user ....................................... 2

#### V
- Violation of UNIQUE KEY constraint ....................... 14

#### W
- web.config ............................................. 6

#### Y
- You do not have permission to create this object. It should be created by the Application that owns the media type on which you are attempting to create this object ............................................. 17